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Formatting

Interior Text and Styling
Once you have your text and images compiled into one file, use Styles and 
Headings to create a consistent look for text and section headings. Use Page 
Breaks instead of hard returns or paragraph breaks to ensure your formatting 
is preserved during the creation of your print-ready PDF file. Apply your own 
spacing rules to styles to maintain a consistent look throughout your book. 
The use of styles allows you to simultaneously edit all text assigned that style 
rather than editing line-by-line.

Interior Color Options
The need for color printing should be considered early in the formatting 
process. Is your work text-only? If so, you can take advantage of our White 
or Cream, 60# Uncoated Standard Black & White products to reduce 
manufacturing costs. For high contrast, grayscale images, Lulu offers a 
White, 80# Coated Standard Black & White. Our White, 60# Uncoated 
Standard Color products allow you to incorporate exciting elements such 
as colored fonts, highlights, charts, graphs, small photos, or low pigment/
saturation color blocks into your printed work without the premium cost.

If you want the highest quality color printing, the Premium Color option 
gives you the quality you need for high resolution photos and Full Bleed page 
coverage. Available on White, 80# Coated and Uncoated paper, you can 
control your price point while exhibiting beautiful graphics and vibrant colors.
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Photo and Graphic Resolution
Pixels per inch (PPI) is used to describe the pixel density of a screen 
(computer monitor, smartphone, etc.). Dots per inch (DPI) refers to the 
print resolution of an image by counting the number of dots per printed inch. 
The more dot’s the higher the quality of the print (more sharpness and detail). 
Most print-ready file formats know how to handle the conversion between 
the PPI and DPI. PDFs allow you to have print-ready files with multiple PPI 
values, but it’s a good idea to consider the desired results before inserting 
just any image size.

72 PPI is the standard resolution for most screens. This may be adequate 
for digital images, but text and details of the graphic could end up looking 
distorted or fuzzy in print. As a general rule, we recommend a minimum of 
150 PPI for simple graphics, and 300 PPI for complex or detailed graphics.

Image Resolution Comparison

300 PPI 

Ideal resolution for complex 

or detailed graphics 

intended for print.

150 PPI

Minimum resolution for 

simple graphics intended 

for print. 

72 PPI

The standard resolution 

for most graphics when 

appearing digitally.
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Document Color Setup
RGB is an additive process, meaning it adds red, green and blue together 
in varying amounts to produce other colors while CMYK is a subtractive 
process that uses different amounts of cyan, magenta, yellow and black to 
remove reflected colors from paper to create other colors we can see. The 
two processes have different ranges of color, with RGB providing a wider 
array of possibilities thus making it used in electronic devices like computer 
monitors. Printing uses CMYK. 

Therefore, we’ve been told to convert RGB colors to CMYK before sending our 
files to print. No harm will be done if you stick to this old habit, but advances 
in printing workflows have eliminated it as a necessity.

Why are the Adobe InDesign templates set up in RGB?

Modern workflows, like our process at Lulu, allow printers to use color profiles 
that automatically match CMYK ink to RGB values to produce results that are 
similar. Following these few simple guidelines will ensure the best color in 
your book: 

1. If you’re starting from scratch, setup your document as an RGB file.
2. We recommend using the sRGB color space in your RGB document 

color profile and applying the sRGB color space to any RGB images or 
links before you make your print-ready PDF.

3. If you’ve already created or converted your file to CMYK and converted 
any images to CMYK, keep it in CMYK and do not switch back to RGB. 
Changing color space settings after finalizing your file may result in 
undesirable color variance.

4. Solid blacks will print solid at 100% with no other colors added. If you 
do add colors to improve the richness of the black, TAC (total area 
coverage) should never exceed 270%.

5. Avoid very light color builds of less than 20%. Below 20% tint variation is 
very difficult to control on a consistent basis.

6. If you are printing a color book that includes black & white images, the 
black & white images should have the color space set to grayscale.
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7. The gamma of a grayscale image should be between 2.2 and 2.4. 
8. Use only high resolution photos (300 DPI or higher) and ensure they are 

consistent with the document color space whether using RGB or CMYK.
9. Use Premium Color Interior printing and 80# Premium Paper when 

printing any book that contains photos or graphics where heavy ink 
coverage is used and a vibrant, colorful printed book is desired. 

Lulu Printer Color Space Profiles:

RGB: sRGB IEC61966–2.1
CMYK: Coated GRACoL 2006
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Anatomy of a Book

FRONT COVERBACK COVER

Book Cover

Book Interior

INTERIOR
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Formatting Terms

Total Document Size

The total dimensions of the file with bleed included.  

Spine Area

The spine width varies based on the number of pages included in your 
book. Use the appropriate formula or table to determine spine width for 
Paperback and Hardcover books. Coil Bound and Saddle Stitch books are 
not glued at the spine, so do not require special calculations.

Safety Margin

We recommend maintaining a border between the trimmed edge 
and important content (e.g. text, images, pages numbers) to prevent 
unintended trimming.

Bleed Area

A border is trimmed from the printed book pages during manufacturing. 
Images, text, or other elements that are intended to extend to the edge 
of the page must fill the bleed area. If a file is uploaded without a bleed 
margin, Lulu must add a 0.125 in margin on all sides to allow proper 
trimming and binding. See “File Dimension and Full Bleed” section 

(page 11).

Barcode Area (Optional)

The recommended area in which your ISBN is placed. Books not intended 
for Global Distribution do not require a barcode or ISBN. Lulu does not 

generate or insert your barcode or ISBN for you. 

Gutter Area (Shown on page 10)

Inner margin for interior pages, allowing for the curve of the page.  
See “Gutter Additions” section (page 10).
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Gutter Area

Gutter Additions
This refers to an extra bit of space on the binding side of facing pages to 
account for the portion of the page inserted and glued into the book binding. 
Coil Bound books do not require a gutter. If your book includes more than 
150 pages, we recommend adding a gutter Margin to your work. If you are 
creating a Paperback or Hardcover, reference the gutter additions table:

Page Count
Add to Interior 

Margin
Recommended  
Interior Margin

Recommended 
Interior Margin 

(Full Bleed)

Less than 60 0 in or 0 mm 0.5 in or 13 mm 0.625 in or 16 mm

61 to 150 0.125 in or 3 mm 0.625 in or 16 mm 0.75 in or 19 mm

151 to 400 0.5 in or 13 mm 1 in or 25 mm 1.125 in or 29 mm

400 to 600 0.625 in or 16 mm 1.125 in or 29 mm 1.25 in or 32 mm

Over 600 0.75 in or 19 mm 1.25 in or 32 mm 1.375 in or 35 mm

INTERIORINTERIOR
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File Dimension and Full Bleed
When books are manufactured, the files are printed then trimmed to 
specification. All book files are printed 0.125 in (3mm) larger on all sides 
than the final trim size in order to account for the final trimming process. For 
accents at the edge of pages, backgrounds and fills, the best results come 
from trimming over the page assets.

If your formatted file does not include imagery that extends to the edge 
of the page, you can prepare your file at the book’s final trim size and our 
system will automatically add a trim border.

If your formatted file includes graphics, fills, or content that extends to the edge 
of the page, use the chart below to determine the ideal interior file dimensions.

Note: If one page of the interior needs to be Full Bleed, then all pages of 
the interior will use the same dimensions.

When to Use Full Bleed Dimensions

Yes

It’s important to prepare 

the print file with Full Bleed 

dimensions for accents and 

graphics intended to extend 

to the page edge.

Yes

When graphics or content 

extends over the edge of the 

page, Full Bleed dimensions 

should be used when 

preparing your file. 

Not Needed

If work is mostly text or 

has distinct white margins 

around the body, then Full 

Bleed dimensions aren't 

necessary.
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Trim Name Trim Size
Interior File 
Dimensions  
- No Bleed

Interior File 
Dimensions  

- With Bleed

Pocketbook 4.25 in x 6.875 in 
108 mm x 175 mm

4.25 in x 6.875 in 
108 mm x 175 mm

4.5 in x 7.125 in 
114 mm x 181 mm

Digest 5.5 in x 8.5 in 
140 mm x 216 mm

5.5 in x 8.5 in 
140 mm x 216 mm

5.75 in x 8.75 in
146 mm x 222 mm

A5 5.83 in x 8.27 in
148 mm x 210 mm

5.83 in x 8.27 in
148 mm x 210 mm

6.08 in x 8.52 in
154 mm x 216 mm

Royal 6.14 in x 9.21 in
156 mm x 234 mm

6.14 in x 9.21 in
156 mm x 234 mm

6.39 in x 9.46 in
162 mm x 240 mm

US Trade 6 in x 9 in 
152 mm x 229 mm

6 in x 9 in 
152 mm x 229 mm

6.25 in x 9.25 in
159 mm x 235 mm

Comic Book 6.63 in x 10.25 in
168 mm x 260 mm

6.63 in x 10.25 in
168 mm x 260 mm

6.88 in x 10.5 in
175 mm x 267 mm

Executive 7 in x 10 in
178 mm x 254 mm

7 in x 10 in
178 mm x 254 mm

7.25 in x 10.25 in
184 mm x 260 mm

Crown Quarto 7.44 in x 9.68 in
189 mm x 246 mm

7.44 in x 9.68 in
189 mm x 246 mm

7.69 in x 9.93 in
195 mm x 252 mm

Small Square 7.5 in x 7.5 in
191 mm x 191 mm

7.5 in x 7.5 in
191 mm x 191 mm

7.75 in x 7.75 in
197 mm x 197 mm

A4 8.27 in x 11.69 in
210 mm x 297 mm

8.27 in x 11.69 in
210 mm x 297 mm

8.52 in x 11.94 in
216 mm x 303 mm

Square 8.5 in x 8.5 in
216 mm x 216 mm

8.5 in x 8.5 in
216 mm x 216 mm

8.75 in x 8.75 in
222 mm x 222 mm

US Letter 8.5 in x 11 in
216 mm x 279 mm

8.5 in x 11 in
216 mm x 279 mm

8.75 in x 11.25 in
222 mm x 286 mm

Small 
Landscape

9 in x 7 in
229 mm x 178 mm

9 in x 7 in
229 mm x 178 mm

9.25 in x 7.25 in
235 mm x 184 mm

US Letter 
Landscape

11 in x 8.5 in
279 mm x 216 mm

11 in x 8.5 in
279 mm x 216 mm

11.25 in x 8.75 in
235 mm x 184 mm

A4 Landscape 11.69 in x 8.27 in
210 mm x 297 mm

11.69 in x 8.27 in
210 mm x 297 mm

11.94 in x 8.52 in
303 mm x 216 mm

Calendar 11 in x 8.5 in
279 mm x 216 mm

11 in x 8.5 in
279 mm x 216 mm

11.25 in x 8.75 in
286 mm x 222 mm
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Cover Layout

Lulu Generated Cover
Our system inserts the information you provide to create a compelling book 
cover complete with the title, subtitle, contributor(s), and description. This is a 
great, quick option when you are short on time or simply need proof copies.

Create & Upload Your Own Cover
Once you have uploaded your interior file, we will generate a cover template 
you can download that is custom crafted to your book’s specifications. By 
creating your own cover, you have full control over the content.

Spine Width Guide
Your cover spine width is determined by the type of book you make and 
the total page count. Paperback covers require a minimum of 32 interior 
pages and use a formula to find the spine width. Hardcover books require a 
minimum of 24 interior pages and use a table with page ranges. 

Note: Lulu provides a cover template after uploading your interior PDF with 
the spine size included. 

Spine Width Calculations

Paperback Covers

Use the formula to calculate the spine width dimension in inches 
or millimeters.

Spine Width in Inches =  
(# of Interior Pages / 444) + 0.06 in

Spine Width in Millimeters =  
(# of Interior Pages / 17.48) + 1.524 mm

IM
PE

RI
AL

M
ET

RI
C
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Hardcover Covers

Use the table to determine the spine width dimension.

Page Count Spine Width (inches) Spine Width (mm)

0-23 N/A N/A

*24-84 0.25 in 6 mm

85-140 0.5 in 13 mm

141-168 0.625 in 16 mm

169-194 0.688 in 17 mm

195-222 0.75 in 19 mm

223-250 0.813 in 21 mm

251-278 0.875 in 22 mm

279-306 0.938 in 24 mm

307-334 1 in 25 mm

335-360 1.063 in 27 mm

361-388 1.125 in 29 mm

389-416 1.188 in 30 mm

417-444 1.25 in 32 mm

445-472 1.313 in 33 mm

473-500 1.375 in 35 mm

501-528 1.438 in 37 mm

529-556 1.5 in 38 mm

557-582 1.563 in 40 mm

583-610 1.625 in 41 mm

611-638 1.688 in 43 mm

639-666 1.75 in 44 mm

667-694 1.813 in 46 mm

695-722 1.875 in 48 mm

723-750 1.938 in 49 mm

751-778 2 in 51 mm

779-799 2.063 in 52 mm

800 2.125 in 54 mm
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Adjusting the Spine Width
Lulu offers templates in different formats that allow cover creation in the 
software you’re most comfortable with. Below is a brief description on how 
to adjust the spine width using Adobe InDesign or Adobe Photoshop. The 
templates are available in PDF and PNG formats as well. Every cover template 
spine guide is preset to the minimum width dimension. Keep this in mind 
when adjusting your spine.

Adobe InDesign

Use the page tool to adjust the spine page width.

1. Locate the Page Tool from the tools panel and select it. 
2. In the pages panel, click on the spine page (page 2 of the spread). The 

page will appear highlighted in the pages panel. Specify the following 
settings in the Liquid Layout control panel (Window > Interactive > 
Liquid Layout):

 ; Liquid Page Rule: Object-based

 ; Object Constraints: Resize with Page: Width

3. After determining your spine dimensions by using the formula 
(Paperback) or the calculator table (Hardcover) found in this PDF, resize 
the page with the Height and Width widgets in the control bar. The 
entire cover should update automatically and is now ready for  
your artwork.

Note: The document must be setup with facing pages checked for the 
front cover page to automatically shuffle.

Watch & Learn on YouTube

• Interior and Cover File Setup Using Adobe InDesign
• Interior and Cover File Setup Using Affinity Publisher
• Cover File Setup Using Adobe Photoshop

https://www.youtube.com/watch?v=IuEIdyafYg4&list=PLkWwfJv6akDZ0KVihVKNcUM-SX7u6QDt8&index=1
https://www.youtube.com/watch?v=khODFLxJz2c&list=PLkWwfJv6akDZ0KVihVKNcUM-SX7u6QDt8&index=3
https://www.youtube.com/watch?v=4ovnzCNmuSo&list=PLkWwfJv6akDZ0KVihVKNcUM-SX7u6QDt8&index=4
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Adobe Photoshop

Adjust the canvas size, revise the spine width, and position the 
cover guides.

1. Subtract the existing minimum spine width dimension listed on the 
front cover from the spine dimension found by using the formula 
(Paperback) or the calculator table (Hardcover) in this PDF and add that 
value to the canvas size. Go to Image > Canvas Size and enter in the 
revised total width dimension.

2. Use the path selection tool to select the spine shape layer in the guides 
folder and enter the correct width dimension found using the formula 
or spine calculator table.

3. Center align the spine guide, right align the front cover guide, and left 
align the back cover guide to the document spread. Make sure guide 
layers are positioned correctly and there are no issues.

Designing For The Spine 
Spine placement can shift slightly during production. To allow for small 
amounts of variance, we encourage authors to follow these guidelines when 
creating your cover and in particular when preparing your spine.

1. Do not include text that fills the entire width of the spine. Any shifting 
will cause text from the spine to run over onto the front or back cover. 
Leave at least 0.125 in between the spine text and the edge of the spine 
on both sides of the text. 

2. Do not include text on projects of 80 pages or fewer. For books with a 
low page count, the slightest shift of spine placement will cause your 
spine text to run over on the front or back cover.

3. Omit any images or solid colors/stark contrast that run right up to and 
stop at the spine on either the front or back cover. Keep the spine the 
same color/graphic as the rest of the cover. 

4. If your spine will be a different color from the rest of the cover, design 
the cover to intentionally include the spine color or graphic wrapping 
around the front and back covers.



FILE CREATION 17LULU BOOK CREATION GUIDE

Trimming & Variance
There are tolerances that should be considered when designing both your 
interior and cover. When building your file, please follow the guidelines below 
to ensure your project is printed correctly. Our trimming tolerance is 0.125 
in toward the front and back cover. Designing your content with sufficient 
margins and variance in mind will help you avoid issues with spine text 
alignment and any cut off text around the edges of your content. 

Trim Edge

This is the edge of the final printed book.

Bleed Edge

Images should be pushed out to the Bleed Edge, 0.125 in past the trim 
edge on every side.

Safety Margin

Text and other important elements should be placed within the Safety 
Margin which is 0.5 in inside the Trim Edge. This will ensure that no text is 
cut off due to variation in the trimming process.

Trim Variance Cover Examples (pages 18-20)

7101227817949
 

ISBN 978-1-79471-012-2
90000  

Back Cover Front CoverSpine

(A5 Paperback)
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7101227817949
 

ISBN 978-1-79471-012-2
90000  

Correct

The background image has been extended 0.125 in past the Trim Edge and 
both the text and important artwork are within the Safety Margin.

Back Cover Front CoverSpine
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7101227817949
 

ISBN 978-1-79471-012-2
90000  

Incorrect

The background image has not been extended to the Bleed Edge. This could 
result in strips of white around the edges of the cover.

Incorrect Formatting Result

Back Cover Front CoverSpine
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7101227817949
 

ISBN 978-1-79471-012-2
90000  

Incorrect

The back cover text and spine text has not been kept within the Safety Margin. 
This could result in text being cut off due to tolerances during trimming.

Incorrect Formatting Result

Back Cover Front CoverSpine
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File Preparation
When you upload your interior file to Lulu’s system, we scan and analyze how 
suitable your work is for print. If it’s just a little off, we will make a few slight 
adjustments. Sometimes our system determines a big change is required. If 
this is the case, we’ll alert you. We strongly recommend you download and 
review your print ready files before completing the publishing process.

Using Lulu’s PDF Job Options 

When creating a PDF with Adobe Products, we recommend using 
Lulu’s Adobe Job Options. Job Options files apply settings when 
exporting your PDF based on our printer requirements. The Job 
Options files (a single page setting for Interior files and a spread 
page setting for Cover files) are included in Lulu’s design bundles 
found on the Product page. 

Job Options files should automatically install when you open the 
file. If they do not, you can manually install the files:

Adobe InDesign

1. Go to: Choose File > Adobe PDF Presets > Define.
2. Click Load and select the .joboptions file.
3. Export your file, select Lulu’s settings from the ‘Adobe 

PDF Preset’ drop-down list to export as a PDF using the 
Job Options settings.

Adobe Photoshop

1. Go to: Edit > Adobe PDF Presets.
2. Click Load and select the .joboptions file.
3. Use ‘Save as Photoshop PDF’ and select the .joboptions 

settings from the drop-down menu.
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Adobe Acrobat Distiller

1. Go to: Settings > Add Adobe PDF Settings.
2. Navigate to the .joboptions file and click OK.
3. The new settings will be available in the ‘Default 

Settings’ drop-down list. Make sure to select them 
before importing your Postscript (.PS) file.

Interior File Specifications
When creating your book with Lulu, you must provide a single page PDF 
containing all interior elements. This includes the title and copyright pages, 
as well as any blank pages you wish to include. 

• Single page, portrait oriented layout
• Embedded images are 300 PPI resolution minimum, not exceeding 600 

PPI resolution 
• Vector images are rasterized
• All fonts are properly embedded
• Transparent layers and vector objects are flattened
• Pages sized to match intended book size—include bleed dimensions 

(0.125 in) with your PDF page size:
Example: 6 x 9 in book requires a PDF with pages sized 6.25 x 9.25 in to 
meet Full Bleed print requirements

• Allow a minimum 0.50 in Safety Margin for all content
• Allow a minimum 0.20 in Gutter Margin for inner edge of all pages
• Do NOT include trim, bleed, or margin lines
• Do NOT use any security / password file protection

Cover File Specifications
Your cover must be a single page integrated spread PDF (back cover, spine 
and front cover) that includes all cover content. Lulu will provide a cover 
template with exact spine dimensions included after you upload your interior 
PDF. We strongly recommend utilizing this template to ensure your cover 
PDF prints and trims correctly.
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Specifications: 

• Embedded images are 300 PPI resolution minimum, not exceeding 600 
PPI resolution

• Vector images are rasterized
• All fonts are properly embedded
• Transparent layers and vector objects are flattened
• Pages sized to match intended book size—see page 13 for spine width 

calculation

• Include bleed dimensions (0.125 in) with your PDF page size
• Allow a 0.5 in Safety Margin for all content
• Do NOT include trim, bleed, or margin lines
• Do NOT use any security / password file protection

Magazine and Comic Book Covers

If you are creating a Magazine or Comic Book product, you will have the 
option to print on the inside front and back cover. This printing requires a 
two-page cover file. Please refer to the Magazine and Comic Book cover 
template for more information.

Proofing
Perhaps one of the most important (and often overlooked) steps of the 
publishing process is the final proof approval. This means you have uploaded, 
printed, and received a physical copy of your work as a reader would receive 
it. Proofing your printed material is critical in troubleshooting and identifying 
mistakes. Some issues you may discover while proofing include:

Human Error
Sometimes when working under a deadline, you do not have time to fully 
review your completed file before going to print. Upon receiving your proof 
copy, you may notice typos or formatting issues. The best solution is to edit 
the interior file, re-upload and order a new proof copy.
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File Error
Low image resolution, transparencies, and unembedded fonts are common 
issues that may not be obvious when viewing your manuscript on a screen. 
While our system will detect and repair many of these issues, some may slip 
through. If you discover an error in your printed book that does not appear in 
your electronic file, please contact us for assistance.

Printing Variance
All manufacturers strive to produce 100% accurate products. However, as 
with any mechanical process, there are tolerances that should be taken into 
account. Our trimming tolerance is 0.125 in toward the front and back cover. 
Designing your content with sufficient margins and variance in mind will help 
you avoid issues with spine text alignment and any cut off text around the 
edges of your content.

Production or Shipping Error
Our goal is to print, bind and deliver the highest quality books possible; 
however, due to the nature of bespoke book production, we cannot 
guarantee 100% perfection for every book. If your book is bent, ripped, torn, 
or exhibits other manufacturing or shipping damage, please contact us for 
assistance.

https://help.lulu.com/en/support/tickets/new
https://help.lulu.com/en/support/tickets/new
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